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Patente und Marken
Die Simple Plex-Technologie von ProteinSimple ist durch erteilte und angemeldete Patente in den USA und anderen 
Ländern geschützt. Weitere Informationen finden Sie unter:  bio-techne.com/support/instrument-support/intellectual-property

ProteinSimple, das ProteinSimple-Logo, Simple Plex und Ella sind Marken oder eingetragene Marken von 
ProteinSimple. Andere in diesen Materialien erscheinende Marken sind Marken ihrer jeweiligen Inhaber.

Hinweise zum geistigen Eigentum
Dieses Handbuch ist durch US-amerikanische und internationale Urheberrechtsgesetze geschützt. Kein Teil dieses 
Handbuchs darf ohne vorherige schriftliche Genehmigung von ProteinSimple ganz oder teilweise, in irgendeiner 
Form oder mit irgendwelchen Mitteln, weder elektronisch noch mechanisch, einschließlich Fotokopie, Aufzeichnung
oder durch ein Informationsspeicher- und -abrufsystem, vervielfältigt, verändert oder übertragen werden.
ProteinSimple erteilt hiermit Kunden, die Ella erworben haben, die Genehmigung, eine begrenzte
Anzahl von Fotokopien oder elektronischen Kopien dieses Handbuchs ohne Änderungen für den eigenen Gebrauch
anzufertigen, sofern diese ausschließlich zum Zweck der Installation oder des Betriebs von Ella verwendet werden.

Die Simple Plex-Software unterliegt den Lizenzbedingungen, die in den standardmäßigen Geschäftsbedingungen 
von ProteinSimple festgelegt sind.

mailto:support@bio-techne.com
http://bio-techne.com/support/instrument-support/intellectual-property
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Ella – Haftungsausschluss
Sofern nicht ausdrücklich in einer Softwarelizenzvereinbarung oder in einem Angebot von ProteinSimple 
angegeben, werden die von ProteinSimple bereitgestellten Produkte und Dienstleistungen „wie besehen“ und 
„wie verfügbar“ ohne jegliche Gewährleistung bereitgestellt. ProteinSimple und seine Lieferanten übernehmen 
keine Gewähr für die Sicherheit, den Datenschutz oder die Genauigkeit von Daten, die über die Produkte oder 
Dienstleistungen bereitgestellt werden. Die Nutzung dieser Daten erfolgt auf eigenes Risiko. Soweit nach 
geltendem Recht zulässig, lehnen ProteinSimple und seine Lieferanten sämtliche ausdrücklichen, stillschweigenden 
oder gesetzlichen Gewährleistungen ab, einschließlich, aber nicht beschränkt auf Gewährleistungen hinsichtlich 
Marktgängigkeit, Eigentum, Nichtverletzung von Rechten Dritter oder Eignung für einen bestimmten Zweck.

Geltungsbereich
Für den ordnungsgemäßen Betrieb des Systems und/oder aller zugehörigen Komponenten müssen die 
Anweisungen in diesem Handbuch streng und ausdrücklich von erfahrenem Fachpersonal befolgt werden.  
Der gesamte Inhalt dieses Handbuchs muss vor Inbetriebnahme des Systems oder seiner Teile vollständig 
gelesen und verstanden werden. Das Nichtlesen, Nichtverstehen oder Nichtbefolgen sämtlicher Inhalte dieses 
Handbuchs vor der Inbetriebnahme des Systems kann zu Schäden an der Ausrüstung oder an deren Teilen sowie 
zu Verletzungen von Personen, die das System bedienen, führen.

Zweckbestimmung
Die Zweckbestimmung des Ella-Geräts ist wie folgt definiert:

Das Ella-Gerät ist ein nicht automatisiertes Gerät, das für die Verwendung in der In-vitro-Diagnostik mit einem 
unterstützten Ella Assay zur Durchführung von Immunassay-Diagnosen bestimmt ist. Das Ella-Gerät  
sequenziert die Verarbeitung von Proben, Reagenzien und Waschpuffern und misst und sortiert 
Fluoreszenzsignale mit einem unterstützten Ella Assay-Kit. Das Ella-Gerät ist für die Verwendung durch 
geschultes Laborpersonal vorgesehen.

Das Ella-Gerät ist zur Verwendung in professionellen Gesundheitseinrichtungen vorgesehen (z. B. in klinischen 
Laboren, Krankenhäusern, Kliniken). Das Ella-System ist nicht für den Einsatz in patientennahen Umgebungen 
oder zur Selbsttestung vorgesehen. Ein vernünftigerweise vorhersehbarer Fehlgebrauch des Produkts umfasst 
Folgendes: 1. Verwendung durch ungeschulte Benutzer 2. Verwendung von nicht unterstützten Kartuschen

Testprinzip
Das Ella-Gerät arbeitet nach dem Sandwich-Immunassay-Testprinzip, das die folgenden Schritte umfasst:

Zunächst wird das Zielantigen mithilfe eines Festphasen-Glass-Nano-Reaktors erfasst, der mit einem 
Fangantikörper beschichtet ist, der spezifisch für das Antigen ist. Die Probe wird durch die Kartusche geleitet, 
um das Zielantigen an den Fangantikörper zu binden. Ein Detektionsantikörper, der an das Antigen bindet, ist 
mit einem fluoreszierenden Marker konjugiert und wird hinzugegeben, wodurch ein sogenannter „Sandwich“-
Komplex entsteht. Nach dem Auswaschen ungebundener Substanzen wird die Kartusche vom Gerät ausgelesen, 
und die relativen Fluoreszenzeinheiten werden erfasst. Die Signalintensität ist direkt proportional zur Menge des 
im Probenmaterial vorhandenen Antigens. Durch den Vergleich des aus der Probe erhaltenen Signals mit einer 
Standardkurve, die aus bekannten Antigenkonzentrationen erstellt wurde, kann die Konzentration des Antigens in 
der Probe bestimmt werden. Dieses Prinzip ermöglicht eine hochspezifische und empfindliche Quantifizierung von 
Antigenen in verschiedenen Proben.

Warnhinweise und Restrisiko
Keine identifiziert.
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Beschreibung der Etiketten und Symbole

Symbol Beschreibung

VORSICHT 
Siehe Begleitdokumentation

NRTL-Zulassungszeichen 
Elektrische Sicherheitszulassung gemäß UL 61010-1:2012, EN 61010-1:2010, CAN/CSA C22.2 
61010-1:2012.

Bestätigung des Herstellers, dass das Produkt die grundlegenden Anforderungen aller 
einschlägigen EU-Richtlinien erfüllt.

WEEE-Symbol 
Getrennte Sammlung von elektrischen und elektronischen Geräten.

Hersteller 
Kennzeichnet den Medizinproduktehersteller gemäß IVDR (2017/746).

In-vitro-Diagnostikum 
Kennzeichnet ein medizinisches Gerät, das zur Verwendung als In-vitro-Diagnostikum bestimmt ist.

Katalognummer 
Kennzeichnet die Katalognummer des Herstellers, anhand der das Medizinprodukt identifiziert 
werden kann.

Eindeutige Gerätekennung 
Eine eindeutige numerische oder alphanumerische Kennung, die die Rückverfolgung und 
Identifizierung des Geräts ermöglicht.
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Kapitel 1

Lernen Sie Ella kennen
Systemübersicht
Ella™ ist ein vollautomatisiertes, kartuschenbasiertes System, das Forschenden ermöglicht, Biomarker in 
verschiedenen Probentypen zu messen. In Kombination mit der Mikrofluidik-Technologie (Simple Plex™-Kartuschen) 
ermöglicht Ella die Messung einzelner Analyte, die gleichzeitige Messung mehrerer Analyte (Multi-Analyte-Modus) 
sowie multiplexe Messungen. Forschende können Simple Plex-Kartuschen zudem so konfigurieren, dass sie 
spezifisch für ihre eigene Forschung sind. 

Mit Ella können Sie: 

•	 Ein Immunassay-Protokoll automatisch ausführen 

•	 Daten automatisch erfassen und verarbeiten 

•	 Fluoreszenz- und Konzentrationsdaten für jeden Analyten und jede Probe anzeigen und auswerten 

•	 Fluoreszenz- und Konzentrationsinformationen für anwendungsspezifische Analysen extrahieren und speichern 

VORSICHT: Das Ella-System ist nicht für den Einsatz in patientennahen Umgebungen oder zur Selbsttestung 
vorgesehen.

Spezifikationen
In diesem Abschnitt werden die Spezifikationen von Ella beschrieben, einschließlich Umgebungsbedingungen, 
elektrischer Nennwerte, physikalischer Merkmale, Laserklassifizierung und externer Absicherung. 

TA B E L L E //  02

Gerätespezifikationen

Umgebungsbedingun-
gen

Nur zur Verwendung in Innenräumen
Höhe bis zu 2000 m (6500 Fuß) 
Temperatur: 18 °C bis 30 °C (65 °F bis 86 °F) 
Luftfeuchtigkeit: 15 bis 80 % r. F., einschließlich, nicht kondensierend

Lagerungs- und 
Transportbedingungen

Temperatur: -18 °C bis 50 °C (0,4 °F bis 122 °F)
Feuchtigkeit: r. F. ≤ 85 %, nicht kondensierend 

Physikalische 
Merkmale

Gesamtabmessungen: �37 cm (B) x 54 cm (T) x 26 cm (H) 
14,6 Zoll (B) x 21,3 Zoll (T) x 10,2 Zoll (H)

Gewicht: 18,2 kg (40,1 lb)

Externe Absicherung Hauptsicherung (Netzanschluss): 4 A, 250 V; IEC 60127 als T4AL 250 V eingestuft

Elektrische Nennwerte 100–240 V (AC), 300 VA, 45/65 Hz, Installationskategorie Klasse (Überspannung) II 
HINWEIS: Die angegebenen elektrischen Werte sind Nennwerte.

Elektrische 
Prüfspezifikationen

CB-Schema: IEC 61010-1:2010

TÜV SÜD „CUE“-Schema:
CAN/CSA-C22.2 Nr. 61010-1:2012
UL 61010-1:2012/R:2019-07
EN 61010-1:2012/R:2019-07
EN 60825-1:2014

Laserprodukt der Klasse 1 gemäß IEC 60825-1:2014 und EN 60825-1:2014

Entspricht den FDA-Leistungsstandards für Laserprodukte gemäß 21 CFR 1040.10 und 
1040.11 mit Ausnahme von Abweichungen gemäß Laserhinweis Nr. 50 vom 24. Juni 2007.
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VORSICHT: Entfernen Sie nicht die Hauptabdeckung von Ella. Im Inneren befinden sich keine vom Benutzer 
zu wartenden Komponenten, und Sie könnten Hochspannung ausgesetzt sein.

VORSICHT: Die Verwendung von Bedienelementen, Einstellungen oder Verfahren, die nicht in diesem 
Handbuch angegeben sind, kann zu gefährlicher Laserstrahlungsexposition führen.

Warnhinweise und Vorsichtsmaßnahmen
In den folgenden Abschnitten werden die Sicherheitsvorkehrungen beschrieben, die beim Umgang mit dem Ella-
System zu beachten sind.

Diese umfassen Vorsichtsmaßnahmen zu:

•	 Allgemeiner Sicherheit

•	 Elektrischer Sicherheit

•	 Laserlichtsicherheit

Allgemeine Sicherheitsvorkehrungen
VORSICHT: Der Bediener von Ella muss von qualifiziertem Fachpersonal in der ordnungsgemäßen Bedienung des 
Geräts geschult werden und über die Sicherheitsrisiken informiert sein. 

Elektrische Sicherheitshinweise
Dieser Abschnitt beschreibt die elektrischen Sicherheitsmaßnahmen für die elektrischen Anschlüsse und 
Sicherungen von Ella sowie die Risiken durch Hochspannung.

Elektrische Anschlüsse
Schließen Sie Ella an einen geerdeten Stromkreis an, der mindestens folgende Leistung liefern kann:

•	 15 Ampere bei einer Netzspannung von 100–120 V

•	 12 Ampere bei einer Netzspannung von 200–240 V Weitere Informationen finden Sie auf dem Typenschild auf 
der Rückseite von Ella.

Sicherung
Der primäre Sicherungshalter befindet sich auf der rechten Rückseite von Ella und enthält eine träge 
Sicherung 4 A, 250 V. Der Sicherungshalter ist für Sicherungen mit den Abmessungen 5 mm × 20 mm ausgelegt. 
Ersatzsicherungen müssen der Norm IEC 60127 entsprechen und mit T4AL 250 V gekennzeichnet sein.

VORSICHT: Schalten Sie Ella aus und trennen Sie das Netzkabel, bevor Sie die Sicherung austauschen. 
Wenn eine Sicherung häufig ersetzt werden muss, liegt möglicherweise ein elektrisches Problem an Ella 
vor. Verwenden Sie Ella in diesem Fall nicht. Es besteht Gefahr eines elektrischen Schlags. Wenden Sie sich 
an den technischen Kundendienst von Bio-Techne.

Hochspannungsgefahr und Vorsichtsmaßnahmen
Der Computer und der Monitor enthalten Hochspannungselektronik. Beachten Sie die Sicherheitsvorkehrungen für 
Computer und Monitor, bevor Sie diese öffnen.

Laser-Sicherheitsvorkehrungen

Ella ist ein Lasergerät der Klasse 1, das einen Laser der Klasse 3B mit einer Wellenlänge von 640 nm enthält. 
Bei den angegebenen Betriebsverfahren lässt Ella keine Exposition des Bedieners gegenüber Laserlicht zu. Das 
Lasersystem von Ella entspricht der Norm IEC (EN) 60625-1:2014.

Kapitel 1 07W-DOC-0024 Rev B



VORSICHT: Versuchen Sie nicht, durch Öffnungen auf das Geräteinnere zuzugreifen. Die Exposition 
gegenüber Laserlicht kann Verletzungen verursachen. Das direkte Betrachten des Laserstrahls kann 
beispielsweise Erblindung verursachen.

VORSICHT: Die Verwendung von Bedienelementen, Einstellungen oder Verfahren, die nicht in diesem 
Handbuch spezifiziert sind, kann zu gefährlicher Strahlenexposition führen.

Bitte beachten Sie die folgenden Sicherheitsmaßnahmen:

•	 Entfernen Sie nicht die Hauptabdeckung von Ella. Im Inneren befinden sich keine vom Benutzer wartungsfähigen 
Komponenten, und Sie könnten Laserstrahlung ausgesetzt sein.

•	 Verwenden Sie Ella nicht weiter, wenn die Hauptabdeckung oder der Kartuschenverschluss beschädigt ist 
oder nicht mehr lichtdicht schließt. Kontaktieren Sie den technischen Kundendienst von Bio-Techne, um eine 
Reparatur zu veranlassen.

Meldung unerwünschter Ereignisse
Wenn Sie einen schwerwiegenden Vorfall melden müssen, der im Zusammenhang mit diesem Medizinprodukt 
aufgetreten ist, setzen Sie sich bitte mit dem Herstellerstandort in Verbindung (siehe Abschnitt Herstellerkontakt) 
und informieren Sie außerdem die zuständige nationale Behörde des Landes, in dem sich der Benutzer und ggf. der 
Patient befinden. 

Benutzerqualifikationen
Personen, die Ella bedienen, warten oder reinigen, müssen in standardisierten Laborsicherheitsverfahren geschult 
sein und diese bei der Handhabung des Geräts einhalten. Sie müssen qualifiziert und geschult sein, um das Ella-
System zu bedienen, die Anweisungen in diesem Benutzerhandbuch vollständig gelesen und verstanden haben und 
mit den geltenden Sicherheitsvorschriften und Richtlinien für die jeweilige Arbeitsumgebung vertraut sein.

Installation von Ella
Die Installation und Betriebsqualifizierung von Ella darf nur durch geschultes Bio-Techne-Personal erfolgen. Ella 
darf erst nach Erhalt eines unterzeichneten Formulars von einem Bio-Techne Mitarbeiter, der eine erfolgreiche  
IQ/OQ-Prüfung bestätigt, in Betrieb genommen werden.

Bewegung von Ella
Ella ist ein empfindliches optisches Gerät, das beschädigt werden kann, wenn es unsachgemäß bewegt wird. 
Ein Herunterfallen kann zu Schäden am Gerät führen. Schalten Sie Ella immer aus, bevor Sie das Gerät bewegen. 
Siehe Abschnitt „Vorbereitung von Ella für den Versand“ auf Seite 22 für Hinweise zur sicheren Bewegung oder 
Transportvorbereitung des Geräts.

VORSICHT: Dieses Produkt muss von zwei Personen angehoben werden. Das Heben schwerer Lasten kann 
Verletzungen verursachen. Verwenden Sie geeignete Hebeverfahren.

VORSICHT: Stellen Sie Ella nicht in die Nähe von Geräten, die starke Vibrationen erzeugen können  
(z. B. Vortex-Mischer),da dies die Messungen beeinträchtigen kann.

Entsorgen Sie das Gerät gemäß den lokalen, regionalen, nationalen, territorialen, provinziellen und 
internationalen Vorschriften. Lesen Sie die Sicherheitsdatenblätter (SDB), um die sichere Entsorgung der 
Materialien für Ihre Region zu bestimmen.

Entsorgung von Ella
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Anschlüsse: Verbindung Ella – Computer
HINWEIS: Pro PC kann nur ein einziges Ella-Gerät angeschlossen und gesteuert werden. Mehrere Geräte können 
nicht gleichzeitig mit demselben PC verbunden werden.

1.	 Netzkabel 
Dient zur Versorgung von Ella mit Wechselstrom (AC). Das Netzkabel muss auf einer Seite über einen IEC 
320-Stecker (Buchse) für den Anschluss an Ella und auf der anderen Seite über einen länderspezifischen 
Netzstecker verfügen. Die Netzkabel müssen UL-gelistet und CSA-zertifiziert sein und eine Stromstärke 
aufweisen, die der elektrischen Spezifikation von Ella entspricht.

2.	Ethernet-Kabel (schwarz) 
Dient zur Kommunikation mit der Hochgeschwindigkeitskamera im Inneren des Geräts.

3.	USB-Kabel 
Dient zur Kommunikation mit allen weiteren Funktionen des Geräts.

Ella-Systemverbindungen
Abbildung 02 zeigt eine Übersicht über die Verbindungen zwischen Ella, dem PC, dem Monitor, der Tastatur und 
dem Barcode-Scanner. Beachten Sie die jeweiligen Installationsanweisungen für Ihr Ella-System und Ihren PC.

A B B I L D U N G //  0 1

Verbindungen von Ella

A B B I L D U N G //  02

Verbindungen von Ella mit dem PC und unterstützenden Peripheriegeräten

USB-Kabel

Ethernet-Kabel

Wechselstromkabel

PCElla
USB-KabelUSB-Kabel

Ethernet-Kabel

Wechselstrom

Barcode-Scanner

Drahtlose Peripheriegeräte

Wechselstrom
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 Minimale IT- und Hardwareanforderungen
Für Ella bestehen keine IT-Netzwerkanforderungen. Es wird nicht empfohlen, Netzwerkverbindungen zu Ella 
herzustellen. Ella arbeitet als eigenständiges System und ist für den Betrieb ohne Netzwerkverbindung vorgesehen. 
Jegliche Verbindungen zu Netzwerken, sei es intra- oder internetzbasiert, erfolgen auf eigenes Risiko. 

Für den Betrieb von Ella ist keine zusätzliche Hardware erforderlich. Der Anschluss zusätzlicher Hardware an Ella 
wird nicht empfohlen und erfolgt auf eigene Verantwortung.

IT-Sicherheitsmaßnahmen
Der Kunde sollte:

1.	 den physischen Zugriff auf das Gerät kontrollieren, um unbefugten Zugriff zu verhindern 

2.	den Zugriff auf den USB-Anschluss des Geräts auf vertrauenswürdige Wechseldatenträger beschränken

Kontaktaufnahme mit dem Kundendienst
Für Kundendienstanfragen oder Bestellinformationen wenden Sie sich bitte an den Kundenservice. 
Für technische Unterstützung wenden Sie sich bitte an den technischen Kundendienst.

Internet		  www.bio-techne.com/brands/proteinsimple

Kundendienst Telefon: 		 1-408-510-5500 
			   1-888-607-9692 (gebührenfrei, nur USA und Kanada)

E-Mail		  orders@proteinsimple.com

Technische 
Unterstützung

Telefon: 		 1-408-510-5500 
			   1-888-607-9692 (gebührenfrei, nur USA und Kanada)

E-Mail		  support@bio-techne.com
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Kapitel 2

Ella starten

Einführung
Ella ist ein vollautomatisiertes, kartuschenbasiertes System, mit dem Sie Mehranalyt-Immunassays mit der Spezifität 
eines herkömmlichen Einzel-ELISA (Enzyme-linked Immunosorbent Assay) durchführen können.

Mit Ella können Sie:

•	 Ein Immunassay-Protokoll automatisch ausführen

•	 Intensitätsdaten automatisch erfassen und verarbeiten

•	 Intensitäts- und Konzentrationsdaten anzeigen und auswerten

•	 Intensitäts- und Konzentrationsinformationen für anwendungsspezifische Analysen extrahieren und speichern

Komponenten des Ella-Systems
Ella besteht aus fünf Hauptkomponenten:

1.	 Ella-Gerät/Lesegerät

2.	Barcode-Scanner

3.	PC

4.	Runner CE-Software

5.	Verifizierungskartusche (Simple Plex-Kartuschen sind separat erhältlich)

Ella
Eine der Hauptkomponenten des Ella-Systems ist ein Tischanalysator ohne integrierte Fluidik, was den 
Wartungsaufwand deutlich reduziert und den Verbrauch von Reagenzien und Abfall minimiert.

Ella wurde nach dem „Load-and-Go“-Prinzip entwickelt. Das System steuert die mikrofluidische Assay-Kartusche 
durch präzise Regelung von Volumina, Flussraten und Flussmustern, ohne dass ein Eingreifen des Anwenders 
erforderlich ist. Nach Abschluss des Assay-Teils eines Laufs führt Ella automatischeine Fluoreszenzmessung, 
Rohdatenverarbeitung und die Berechnung von RFU (relative fluorescence units, relative Fluoreszenzeinheiten) 
sowie Analytenkonzentrationen pro Analyten und pro Probe durch. Ein Netzkabel ist im Lieferumfang des Geräts 
enthalten.

Barcode-Scanner
Das Ella-System beinhaltet einen universellen, handgeführten Barcode-Scanner, der sowohl 1D- als auch 
2D-Barcodes omnidirektional lesen kann. Jedes von Bio-Techne gelieferte Kartuschen-Kit ist mit einem  
Data-Matrix-2D-Barcode versehen, der alle relevanten Kit-Daten enthält, darunter:

•	 Chargeninformationen

•	 Biomarker-Panel-Informationen

•	 Konfigurationsdaten der Kartusche
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A B B I L D U N G //  03

Kartuschen, die in Ella verwendet werden

VORSICHT: Jede Konfiguration, die nicht die Runner CE-Software und die unterstützten CE-
gekennzeichneten Kartuschen verwendet, entspricht nicht der zugelassenen CE-Systemkonfiguration.  

Jeder Kartuschenlauf beginnt mit dem Scannen des Kartuschen–Kit-Barcodes, damit dem Benutzer alle relevanten 
Kartuschen-Kit-Daten angezeigt werden und die Software über die erforderlichen Informationen verfügt, um den 
Lauf sowie die Rohdatenverarbeitung durchzuführen.

PC
Ein PC ist im Lieferumfang von Ella enthalten, um die Systemsteuerung zu ermöglichen. Ein USB-Kabel und ein 
Netzwerkkabel werden zur Verbindung mit Ella mitgeliefert.

Simple Plex-Software 
Runner CE ist ein headless Software-System, das für das Ausführen der Kartuschen sowie für die Schnittstelle mit 
einer vom Assay-Entwickler erstellten GUI vorgesehen ist. Runner CE ist auf dem mit dem Ella-System gelieferten 
PC vorinstalliert. Für Informationen oder Unterstützung bei der Entwicklung einer eigenen GUI wenden Sie sich bitte 
an Bio-Techne. 

Verifizierungskartusche
Die Verifizierungskartusche dient als wiederverwendbare Referenz und ist erforderlich, um einen Geräte-Selbsttest 
durchzuführen. Siehe Abschnitt „Ella-Selbsttest“ auf Seite 21 für weitere Informationen.

Simple Plex-Kartuschen und -Assays
Die gebrauchsfertige IVD-Kartusche ist im 32-Proben-Multianalyten-Format erhältlich (siehe Abbildung 03).  
Die Kartusche wurde mit einem für Ihre Forschung spezifischen Panel entwickelt, damit Sie den Barcode scannen, 
Ihre Proben und den Puffer in die Kartusche einfüllen, die Kartusche in den Kartuschenhalter von  
Ella einsetzen und den Lauf starten können. Simple Plex-Kartuschen und -Assays sind nicht im Lieferumfang des 
Ella-Systems enthalten. Verwenden Sie nur Kartuschen und Assay-Kits, die für das Ella-Gerät freigegeben sind. 

Jede Kartusche verfügt über mehrere Probenzuläufe. Jeder Probenzulauf enthält bis zu vier dedizierte Kanäle. 
Ein einzelner Kanal enthält drei Glass-Nano-Reaktoren (GNR), die mit einem Fangantikörper funktionalisiert sind, 
sodass für jeden Analyten einer Probe drei Messwerte erfasst werden können. Der GNR enthält den Immunassay 
und basiert auf R&D Systems-Reagenzien, um hohe Qualität und reproduzierbare Sensitivität sicherzustellen. Die 
Gesamtheit der GNRs innerhalb eines Kanals in einem bestimmten Probenzulaufbildet die Messgrundlage der auf 
einer Simple Plex-Kartusche durchgeführten Analysen.

Verifizierungskartusche
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SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

Test- und 
Kalibrierkartusche
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SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

32x4 Simple Plex-Kartusche

32 Proben, 4 Analyten
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SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025
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Starten und Herunterfahren von Ella
Befolgen Sie die in diesem Abschnitt beschriebenen Verfahren zum Positionieren, Starten und Herunterfahren von 
Ella.

HINWEIS: Beim Positionieren von Ella ist darauf zu achten, dass sich an der Rückseite ausreichend Freiraum 
befindet, damit der Bediener problemlos auf den Netzschalter und das Netzkabel zugreifen kann. Wenn der 
Bediener der Vorderseite von Ella zugewandt ist, befinden sich der Netzschalter und das Netzkabel auf der 
Rückseite des Geräts, unten links.

Starten des Systems
So starten Sie Ella:

1.	 Schalten Sie Ella ein.

2.	Schalten Sie den Computer und Monitor von Ella ein.

3.	Melden Sie sich am PC an und starten Sie die 
Software. 

4.	Nach dem Hochfahren von Ella leuchtet die 
Statusanzeige (siehe Abbildung 04). Eine 
Beschreibung der Statusanzeige finden Sie in 
Tabelle 3.

Einschalten von Ella
Drücken Sie den Netzschalter auf der Rückseite von 
Ella.

Herunterfahren des Systems
So fahren Sie Ella herunter:

1.	 Fahren Sie den Computer von Ella herunter.

2.	Schalten Sie Ella aus, indem Sie den Netzschalter 
auf der Rückseite betätigen.

TA B E L L E //  03

Statusanzeigen der Ella-Leuchte
A B B I L D U N G //  04

Statusanzeige von Ella

Helle Farbe Status

● Grün Ella ist eingeschaltet und 
betriebsbereit.

● Blau Ella führt einen Kartuschenlauf 
durch.

● Rot blinkend
Es ist ein Fehler aufgetreten (Ella 
kann optional einen akustischen 
Alarm ausgeben).

Kapitel 2 13W-DOC-0024 Rev B



Kapitel 3

Durchführen eines  
Simple Plex-Kartuschenlaufs

Einführung
Der folgende Abschnitt dient nur zu Informationszwecken. Bitte beachten Sie das Spezifikationsblatt und die 
Produktdokumentation, um weitere Informationen zur Durchführung Ihres Kartuschenlaufs zu erhalten. 

Durchführen eines Kartuschenlaufs
Zum Durchführen eines Laufs benötigen Sie:

•	 Ihre Proben

•	 Ihr Barcode-beschriftetes Kartuschen-Kit (siehe Abbildung 05), das Folgendes enthält:

a.	 Waschpuffer A

b.	Probenverdünnungsmittelkomponente(n)

c.	 Kartusche

Typischer Ablauf eines Laufs:

1.	 Reagenzien vorbereiten

2.	Kartusche vorbereiten

3.	Mit Ella konfigurieren und Lauf starten

Barcode-Etiketten
Kit-Etikett

Es befindet sich auf der Außenseite des Kartuschenbeutels, rot markiert in Abbildung 05.

A B B I L D U N G //  05

Kartuschen-Kit.

Verpacktes Kit Waschpuffer und Probenverdünnung Kartusche im Beutel, 
einschließlich Barcode-Etikett 
(rot markiert)
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Kartuschenetikett

Das Barcode-Etikett der Kartuschen (siehe Abbildung 06) befindet sich direkt auf der Kartusche und dient dazu, 
die Kartusche dem jeweiligen Kit eindeutig zuzuordnen. Dieses Barcode-Etikett der Kartusche bestätigt, dass die 
verwendete Kartusche mit dem zugehörigen Kit übereinstimmt. 

Kartuschen-ID-Barcodes befinden sich auf der Vorderseite der Kartusche, nahe dem unteren Rand, wie in 
Abbildung 06 gezeigt.

Vorbereitung von Proben und Reagenzien
Plasmaproben (EDTA oder Heparin) und Serumproben

Serum- und Plasmaproben, die gemäß dem im Assay-Spezifikationsblatt empfohlenen Protokoll vorbereitet wurden 
und keine sichtbaren Partikel enthalten, müssen nicht zentrifugiert werden, bevor sie in einem Simple Plex-Assay 
verwendet werden.

Für Serum- und Plasmaproben, die sichtbare Partikel enthalten, wird empfohlen, diese durch Zentrifugation zu 
entfernen und die Proben gemäß den Anweisungen im Assay-Spezifikationsblatt zu verdünnen. Die nachstehend 
beschriebene Methode dient der Probenkonservierung, kann jedoch bei Bedarf an Probenverfügbarkeit oder 
Partikelgehalt angepasst werden. Die Methode simuliert die Probenvorbereitung für die 1:2-Mindestverdünnung 
(MRD), die in den meisten Simple Plex-Assays erforderlich ist. Für höhere Verdünnungsfaktoren kann zur 
Genauigkeit eine serielle Verdünnung erforderlich sein.

Zentrifugation für Serum- und Plasmaproben

1.	 Aliquotieren Sie 35 µL Serum oder Plasma in ein Mikrozentrifugenröhrchen.

2.	Zentrifugieren Sie die Probe bei 8.000–10.000 g für mindestens 4 Minuten.

3.	Aliquotieren Sie 30 µL der entsprechenden Probenverdünnung in ein anderes Mikrozentrifugenröhrchen.

4.	Nach der Zentrifugation entnehmen Sie 30 µL der überstehenden Flüssigkeit, ohne das Pellet am Boden  
zu stören.

5.	Geben Sie die 30 µL der zentrifugierten Probe zu den 30 µL der aliquotierten Verdünnung und mischen  
Sie gründlich.

6.	Pipettieren Sie 50 µL der 1:2-verdünnten Probe in den vorgesehenen Kartuschenkanal.

Andere Probentypen

Optimale Verdünnungen sollten vom Endbenutzer bestimmt werden.
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SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025
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SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025
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Kartuschen-ID-Barcodes.

Kartuschen-ID-Barcodes: Volle 32×4-Kartuschenvorderseite (links). Gezoomte Detailansicht zeigt Kartuschendetails und Barcode (rechts).
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Kartusche vorbereiten
HINWEIS: Beim Umgang mit Kartuschen wird empfohlen, stets Handschuhe zu tragen und die Kunststoffrückseite 
erst unmittelbar vor dem Einsetzen der Kartusche in Ella zu entfernen.

Verfahren

1.	 Scannen Sie den Kit-Barcode auf der Außenseite des Kartuschenbeutels.

2.	Entnehmen Sie die Kartusche aus dem Vakuumbeutel.

3.	Scannen Sie den Kartuschen-Barcode.

4.	Pipettieren Sie die Proben in der folgenden Reihenfolge in die Kartusche:

a.	 Geben Sie zuerst den Waschpuffer gemäß der Kartuschenanleitung hinzu.

b.	Fügen Sie anschließend die verdünnte Probe hinzu, die der Kartusche entspricht.

5.	Ziehen Sie die Schutzfolie vom Boden der Kartusche ab.

6.	Setzen Sie die Kartusche in den Kartuschenhalter von Ella ein. 
 
HINWEIS: Nach dem Entfernen der Folie ist darauf zu achten, dass der Boden der Kartusche nicht berührt oder 
auf eine Oberfläche gelegt wird.

7.	 Schließen Sie den Kartuschenverschluss und den Deckel.

Die Abfolge der Kartuschenvorbereitung ist in Abbildung 07 dargestellt.

A. Kartusche vorbereiten

1.	 Scannen Sie den 
Barcode.

A B B I L D U N G //  07

Schrittweise Anleitung zur Vorbereitung einer Kartusche für den Lauf mit Ella.

2.	Entfernen Sie das 
Schutzgehäuse der 
Kartusche.

3.	Scannen Sie den 
Kartuschen-Barcode zur 
Bestätigung (optional).

4.	Pipettieren Sie den Puffer 
ein.

5.	Pipettieren Sie die 
Probe ein.

6.	Entfernen Sie die 
Schutzfolie 
bzw. die Abdeckung.
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B. Kartusche in Ella laden

A B B I L D U N G //  07

Schrittweise Anleitung zur Vorbereitung einer Kartusche für den Lauf mit Ella (Fortsetzung).

1.	 Öffnen Sie die Tür von Ella.

2.	Öffnen Sie die 
Kartuschenklemme.

3.	Öffnen Sie die Tür und 
Klemme von Ella.

4.	Laden Sie die Kartusche in Ella.

5.	Schließen Sie die 
Kartuschenklemme.

6.	Schließen Sie die Tür.

VORSICHT: Achten Sie darauf, keine Flüssigkeit in die Kartuschenaufnahme zu verschütten. 

Simple Plex Runner CE
Eine headless, nicht interaktive Version von Runner CE 
ist über die versteckten Symbole in der Taskleiste Ihres 
Desktops verfügbar (siehe Abbildung 08). Mit dieser 
Version können Sie Runner-Einstellungen ändern, 
Ella-Plattform bewegen oder Diagnose- bzw. andere 
Datendateien exportieren. 

A B B I L D U N G //  0 8

Symbol für Simple Plex Runner CE

Klicken Sie auf Settings > Application (Einstellungen > 
Anwendung) im Menü, um das Dialogfeld Settings 
(Einstellungen) anzuzeigen (siehe Abbildung 09). Ein 
Klick auf eine Zeile im Dialogfeld zeigt am unteren 
Rand eine detaillierte Beschreibung des ausgewählten 
Elements an. Diese Beschreibungen sind in Tabelle 04 
aufgeführt. Wenn Änderungen vorgenommen wurden, 
wird die Schaltfläche Save (Speichern) aktiviert.

A B B I L D U N G //  0 9

Dialogfeld für Einstellungen von Simple Plex 
Runner CE
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A B B I L D U N G //  1 0

Umbenennen des Ella-Geräts in den Einstellungen von Simple Plex Runner CE

Klicken Sie auf Settings > Analyzer > Description (Einstellungen > Messgerät > Beschreibung), um ein Dialogfeld 
zu öffnen, in dem Sie das Ella-Gerät umbenennen können (siehe Abbildung 10). Der hier eingegebene Gerätename 
wird in der integrierten Software von Ella gespeichert und bleibt auch bei einem PC-Wechsel erhalten. Dieser Name 
wird allen vom Gerät erzeugten .cydat-Dateien zugeordnet.

Parameter Beschreibung

Use21CFRPart11Mode  
(21CFRTeil11-Modus)

Legt fest, ob der 21 CFR Part 11-Support verwendet wird (Anmeldung, Prüfpfade, 
Datenverschlüsselung usw.). Der 21 CFR Part 11-Support muss aktiviert sein, damit diese 
Einstellung wirksam wird.

AutoLockInactivityMinutes  
(AutomatischeSperreInaktivitätsdauer)

Bestimmt die Dauer einer Inaktivitätsperiode, nach der der Anmeldebildschirm 
automatisch gesperrt wird, wenn der 21 CFR Part 11-Modus aktiviert ist. Zum Deaktivieren 
dieser Funktion auf 0 setzen.

LogoutWhenDone  
(AbmeldenNachAbschluss)

Wenn true (wahr) (Standard), wird der aktuelle Benutzer nach Auswahl von Done (Fertig) 
in der Option Kit Results (Kit-Ergebnisse) abgemeldet. Wenn false (falsch), bleibt der 
Benutzer angemeldet und die Anwendung wechselt zu Option New Kit (Neues Kit).

AllowOutputFilePathChange  
(ÄnderungDesAusgabedateipfadsZulas-
sen)

Wenn false (falsch), können der Dateiname und der Speicherort der Ergebnisdatei des 
Kits nicht geändert werden. Diese Einstellung gilt auch für die generische LIMS-
Exportdatei (falls aktiviert). Diese Einstellung ist nur im 21 CFR Part 11-Modus verfügbar.

KitResultsFileDefaultFolder  
(StandardordnerFürKitErgebnisdateien)

Das gemeinsame Verzeichnis, in dem die Kit-Ergebnisdatei ausgegeben wird  
(*.cydat-Erweiterung).

AlwaysShow3DecimalsFor 
Concentration (Immer3Dezimalstellen-
FürKonzentrationAnzeigen)

Zeigt immer drei Dezimalstellen für Konzentrationswerte an. Standardmäßig basiert die 
Anzahl der angezeigten Dezimalstellen auf der Anzahl der signifikanten Stellen in der 
Messung. Diese Einstellung legt fest, dass Konzentrationswerte mit drei Dezimalstellen 
exportiert werden.

GnrFilter (GnrFilter)
Der Filter, der zur Auswahl der resultierenden GNRs verwendet wird. None (Keine) 
bedeutet, dass alle GNRs ausgewählt werden. RFU und Concentration CV (Konzentration 
des Variationskoeffizienten) führen eine Ausreißerentfernung durch, wenn der 
prozentuale CV-Wert aller drei GNRs über dem angegebenen Schwellenwert liegt.

GnrFilterPercentCVThreshold  
(ProzentCV-SchwellenwertFürGnrFilter) Der prozentuale CV-Schwellenwert, der vom GnrFilter verwendet wird.

UseSampleStandardDeviation  
(StichprobenstandardabweichungVer-
wenden)

Präferenz für die Berechnung des prozentualen CV-Werts. Wenn aktiviert, wird die 
Stichproben-Standardabweichung verwendet. Andernfalls wird die Populations-
Standardabweichung verwendet (Standard).

ResultWarning (Ergebniswarnung)

Diese Einstellung gilt für alle Kartuschentypen mit Ausnahme von 32x8 und 72x2. Sie legt 
fest, ob ein Analyt-Ergebnis im Results Summary View (Ansicht der Ergebnisübersicht) 
hellrosa markiert werden soll, wenn der relevante prozentuale CV-Wert größer oder 
gleich dem angegebenen Schwellenwert ist. Wenn Use Filter Setting (Filtereinstellung 
verwenden) aktiviert ist, werden der anwendbare CV-Wert und der Schwellenwert aus 
den Einstellungen GnrFilter und GnrFilterPercentCVThreshold übernommen.  
Der Standardwert ist UseFilterSetting.

ResultWarningHighCVPercent 
Threshold (SchwellenwertFürHohenCV-
ProzentwertDerErgebniswarnung)

Der prozentuale CV-Wert, der von ResultWarning verwendet wird. Der Standardwert 
beträgt 10.

ResultWarning2Gnrs  
(Ergebniswarnung2GNRs)

Diese Einstellung gilt nur für Kartuschentypen 32x8 und 72x2. Sie legt fest, ob ein 
Analyt-Ergebnis im Results Summary View (Ansicht der Ergebnisübersicht) hellrosa 
markiert werden soll, wenn der relevante prozentuale CV-Wert größer oder gleich dem 
angegebenen Schwellenwert ist. Der Standardwert ist Off (Aus).

ResultWarning2GnrsHighCV 
PercentThreshold (SchwellenwertFür-
HohenCVProzentwertDerErgebniswar-
nung2GNRs)

Der prozentuale CV-Wert, der von ResultWarning2Gnrs verwendet wird.  
Der Standardwert beträgt 20.

TA B E L L E //  04

Runner CE-Einstellungen.
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Parameter Beschreibung

AutoExportKitResultsSummary-
Report (AutomatischerExportDe-
sKitErgebnisberichts)

Legt fest, ob am Ende eines Laufs und jedes Mal, wenn die Kit-Ergebnisdatei 
gespeichert wird, automatisch ein Ergebnisübersichtsbericht exportiert werden soll. 
Der Speicherort und der Name der Datei entsprechen der Kit-Ergebnisdatei  
(*.cydat oder *.ceydat), wobei die Dateierweiterung in *.pdf geändert wird.

DemoModeEnable  
(DemomodusAktivieren)

Die Anwendung läuft im Demo-Modus und erfordert kein angeschlossenes  
Ella-System.

KitRunDataRepositoryEnabled 
(KitLaufdatenRepositoryAkti-
viert)

Legt fest, ob das Kit Run Data Repository (Datenspeicher für Kit-Läufe) (KRDR) aktiviert 
ist. Das KRDR umfasst alle Diagnosedaten für einen Lauf sowie ein Backup der 
Kit-Ergebnisdateien. Wenn es deaktiviert ist, ist keine Wiederherstellung von Kit-
Ergebnisdateien möglich.

KitRunDataRepository  
(KitLaufdatenspeicher)

Das Stammverzeichnis, in dem alle Diagnosedaten für einen Kit-Lauf sowie ein Backup 
der Kit-Ergebnisdateien gespeichert werden. Ordner werden nach Datum und nach der 
Kit-ID des Laufs organisiert.

LocalKitRunDataRepository 
AutoPurgeEnabled (Automatisch-
eLöschungLokalesKitLaufdaten-
speicherAktiviert)

Legt fest, ob ältere Daten in einem lokalen Kit Run Data Repository (Datenspeicher für 
Kit-Läufe) (KRDR) automatisch gelöscht werden. Die automatische Löschfunktion gilt 
nicht für ein KRDR auf einem Netzwerk- oder freigegebenen Laufwerk.

LocalKitRunDataRepository 
AutoPurgeDaysToRetain  
(AufbewahrungstageFürLokalen-
KitLaufdatenspeicher)

Legt die Anzahl der Tage fest, für die Daten aufbewahrt werden, wenn 
LocalKitRunDataRepositoryAutoPurgeEnabled auf True (Wahr) gesetzt ist. Der 
Standardwert für die Aufbewahrungsdauer lokaler Kit-Lauf-Daten beträgt 90 Tage.

Generate2DMeasureScanData 
(2DMessdatenErzeugen)

Erstellt zusätzliche Diagnosedaten für Mess-Scans. Erhöht den Speicherplatzbedarf 
des Kit Run Data Repository (Datenspeicher für Kit-Läufe) um bis zu 25 %.  
Der Standardwert ist True (Wahr).

AutoExportKitResultsTo 
GenericLIMSFile (Automatischer-
ExportDerKitErgebnisseInGeneri-
scheLIMSDatei)

Legt fest, ob am Ende eines Laufs automatisch eine generische LIMS-Exportdatei 
erstellt werden soll.

GenericLIMSExportFileDefault 
Folder (StandardordnerFürGene-
rischeLIMSExportdatei)  

Standardverzeichnis, in das die automatisch generierte generische LIMS-Exportdatei 
(*.csv) ausgegeben wird.

GenericLIMSAutoExport 
AppendSampleAggregateData 
(AutomatischesAnhängenAggre-
gierterProbendatenAnGeneri-
scheLIMSExportdatei) 

Wenn True (Wahr), wird eine zusammengefasste Stichprobendatentabelle am Ende der 
automatisch generierten generischen LIMS-Exportdatei angehängt.

GenericLIMSAutoExport 
ColumnsSameAsImport (Spalten-
layoutWieImportdateiFürAutoma-
tischenLIMSExportVerwenden)

Legt fest, ob die automatisch generierte generische LIMS-Exportdatei dieselben 
Spalten wie die Importdatei verwendet (wenn aktiviert). Andernfalls wird das 
Standardformat verwendet.

ShowConcentrationOutOf 
RangeIndicationForExport 
(AnzeigeFürKonzentrationen-
AußerhalbDesMessbereichsBei-
mExport)

Wenn True (Wahr), werden Konzentrationswerte außerhalb des Messbereichs für 
generische LIMS-Exporte angezeigt, z. B. als verdünnungsfaktorbasierte Untergrenze 
(LLOQ) oder Obergrenze (ULOQ) mit einem Präfix „<“ oder „>“ (z. B. „<2,00“ oder 
„>5000“). Wenn False (Falsch), bleiben diese Werte leer.

GenericLIMSImportFileDefault 
Folder (StandardordnerFürGene-
rischeLIMSImportdatei)

Standardverzeichnis zur Auswahl der generischen LIMS-Importdatei (*.csv).

UseGenericLIMSImportFile 
DefaultFolder (Standardordner-
FürGenerischeLIMSImportdatei-
Verwenden)

Legt fest, ob das im Parameter GenericLIMSImportFileDefaultFolder angegebene 
Standardverzeichnis für den Import verwendet werden soll. Wenn das 
Standardverzeichnis nicht verwendet wird, wird standardmäßig das zuletzt verwendete 
Verzeichnis genommen.

ComPortName (ComPortName) Kommunikationsanschluss zum Gerät.

BarcodeScannerComPortName 
(BarcodeScannerComPortName) Kommunikationsanschluss zum Barcode-Scanner.

BeepOnRunError (SignaltonBei-
Laufzeitfehler)

Gibt an, ob Ella bei Auftreten einer Fehlersituation während eines Laufs einen Signalton 
ausgeben soll, um die Aufmerksamkeit des Benutzers zu erregen.

RequireCartridgeBarcodeScan 
(KartuschenBarcodeScanErfor-
derlich)

Erfordert das Scannen des Kartuschen-Barcodes in der Option New Kit (Neues Kit).

SelfTestDataRepository (Selbst-
testDatenspeicher)

Stammverzeichnis, in dem alle Selbsttestdaten gespeichert werden. Die Ordner sind 
nach der Ella-Nummer und anschließend nach Testdatum und -uhrzeit organisiert.
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Runner CE-Einstellungen.
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Datenspeicher
Die Simple Plex Runner CE-Software ist so konfiguriert, dass sie die mit jedem Kit- und Selbsttestlauf verbundenen 
Daten speichert. Diese Daten werden in Datenspeichern abgelegt, die nach Datum und Lauf organisiert sind.

Kit Run Data Repository (Datenspeicher für Kit-
Läufe) (KRDR)

•	 Ermöglicht die Sicherung und Wiederherstellung von 
CYDAT-Dateien für jeden Kit-Lauf.

•	 Stellt Diagnosedaten für den unwahrscheinlichen 
Fall von Systemproblemen bereit.

Self Test Data Repository (Datenspeicher für 
Selbsttestdaten) (STDR)

•	 Enthält eine abrufbare Historie aller Selbsttestläufe.

•	 Stellt Diagnosedaten für den unwahrscheinlichen 
Fall von Systemproblemen bereit.

Der Speicherort der Speicher kann in den Anwendungseinstellungen der Simple Plex Runner CE-Software 
konfiguriert werden.

Wiederherstellen einer CYDAT-Datei
Wenn Sie das KRDR verwenden und eine CYDAT-Datei aus einem Lauf verloren oder verlegt haben, können Sie 
diese CYDAT-Datei wiederherstellen, indem Sie in der Simple Plex Runner CE-Software die Option File > Recover 
Kit Results (Datei > Kit-Ergebnisse wiederherstellen) auswählen. Durch diese Option wird die angegebene  
Kit-CYDAT-Datei im Speicher lokalisiert und eine Kopie davon am gewünschten Speicherort erstellt.

Anzeigen/Abrufen der Selbsttests
Wenn Sie in der Simple Plex Runner CE-Software unter Tools > Self Test History (Werkzeuge > Selbsttestverlauf) 
die Option Self Test History (Selbsttestverlauf) auswählen, wird eine Liste aller Selbsttests im Speicher angezeigt, 
die nach Ella-System und Datum organisiert ist. Sie haben außerdem die Möglichkeit, einen oder mehrere 
Selbsttestberichte abzurufen/zu speichern. Alle Detailergebnisse der Selbsttests können angezeigt werden.
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Kapitel 4

Wartung von Ella
Einführung
Dieses Kapitel beschreibt Wartungs- und 
Serviceaufgaben für Ella. Siehe Kapitel 3, um auf 
Simple Plex Runner CE zuzugreifen.

Verwendung des Simple Plex Runner  
CE-Menü Werkzeuge 

Das Menü Tools (Werkzeuge) (Abbildung 11) wird 
verwendet, um die XY-Plattform an vordefinierte 
Stellen zu verschieben (muss bei geschlossener 
Klemme und geschlossenem Deckel erfolgen) und 
Diagnosesystemprotokolle in eine komprimierte Datei 
zu exportieren, die vom technischen Kundendienst 
verwendet werden kann.

A B B I L D U N G //  11

Simple Plex Runner CE-Menü Werkzeuge
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Ella-Verifizierungskartusche.

Ella-Selbsttest
Die Ella-Verifizierungskartusche ermöglicht es dem System, eine Reihe diagnostischer Tests durchzuführen, um 
sicherzustellen, dass das Gerät ordnungsgemäß funktioniert. Die Runner CE-Software unterstützt die Mechanismen zur 
Durchführung eines Selbsttests, jedoch muss die Benutzeroberfläche (GUI) vom Assay Developer entwickelt werden, um 
den Test auszuführen. Für Informationen oder Unterstützung bei der Entwicklung einer eigenen GUI wenden Sie sich bitte an 
Bio-Techne. 

Die Ergebnisse werden in den Systemprotokollen aufgeführt. Diese Ergebnisse liefern wertvolle Informationen für den 
technischen Support von Bio-Techne, falls eine Systemwartung erforderlich ist. Wir empfehlen, die Verifizierungskartusche 
wöchentlich zu verwenden, um eine fortlaufende Verlaufskontrolle der Systemleistung zu erstellen.

Ihre Verifizierungskartusche wurde in einer Aufbewahrungsbox geliefert, wie in Abbildung 12 A und B dargestellt. Tragen Sie 
beim Umgang mit der Verifizierungskartusche Handschuhe, um Verschmutzungen zu vermeiden. Die Verifizierungskartusche 
verfügt über eine Oberfläche zum Abdichten der pneumatischen Schnittstelle von Ella sowie über eine autofluoreszierende 
Oberfläche als RFU-Referenz.

VORSICHT: Verwenden Sie keine Verifizierungskartusche über das aufgedruckte Verfallsdatum hinaus. 
Dieses Datum ist entweder auf der Kartusche selbst oder auf der Kalibrierungszertifizierung angegeben. 

A. 
Verpackungsbox der 
Verifizierungskartusche.

B. 
Kartusche in der Box, 
mit Barcode nach oben.

 

Verwendung der „Move To“-Befehle (Positionsbefehle) in der Simple Plex Runner CE-Software
Öffnen Sie Simple Plex Runner CE.

Position des Objektfensters
Der Befehl Tools > Move To > Objective Window Position (Werkzeuge > Position > Position des Objektfensters) wird 
verwendet, um die XY-Plattform in die korrekte Position zu bewegen, um das Objektfenster, das in die Heizplatte 
eingeschraubt ist, zu entfernen oder zu installieren.
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Position zum Einsetzen der Kartusche 
Der Befehl Tools > Move To > Cartridge Load Position (Werkzeuge > Position > Position zum Einsetzen der Kartusche) 
wird verwendet, um zur Ladeposition zurückzukehren, wenn zuvor zur Objektfensterposition oder Versandposition 
gewechselt wurde. Er wird auch in dem äußerst unwahrscheinlichen Fall verwendet, dass das Gerät die Plattform nicht 
automatisch in die Ladeposition zurückfährt. In diesem Fall wenden Sie sich bitte an den technischen Kundendienst von 
Bio-Techne. 

Versandposition 
Der Befehl Tools > Move To > Ship Position (Werkzeuge > Position > Versandposition) wird verwendet, wenn Ella für den 
Versand verpackt werden soll.

Vorbereitung von Ella für den Versand
So bereiten Sie Ella für den Versand vor:

1.	 Schließen Sie die Klemme und den Deckel.

2.	Klicken Sie im Simple Plex Runner CE-Menü auf Tools > Move To > Ship Position (Werkzeuge > Position > 
Versandposition).

3.	Warten Sie, bis das Dialogfenster Moving to shipping position (Bewegen in die Versandposition) geschlossen wird.

4.	Fahren Sie Ella herunter:

a.	 Schließen Sie Simple Plex Runner CE, indem Sie im Menü auf File > Exit (Datei > Beenden) klicken oder Close 
(Schließen) (X) in der oberen rechten Ecke des Anwendungsfensters auswählen. Schließen Sie die Software. 
Fahren Sie den Computer von Ella herunter.

b.	 Schalten Sie Ella aus, indem Sie den Netzschalter auf der Rückseite betätigen.

Exportieren von Systemprotokollen
Öffnen Sie Simple Plex Runner CE.

Wählen Sie Tools > Export Diagnostic Data for Technical Support (Werkzeuge > Diagnosedaten für den technischen 
Support exportieren), um Diagnosedaten in eine komprimierte ZIP-Datei zu exportieren, wenn dies vom technischen 
Support angefordert wird.

Wartung und Reinigung
Für Ella ist eine jährliche vorbeugende Wartung durch einen Vertreter von Bio-Techne erforderlich. Eine Kalibrierung 
durch den Benutzer ist nicht notwendig. Dennoch wird empfohlen, das System regelmäßig zu kontrollieren. Achten 
Sie auf mögliche Beschädigungen des Gehäuses von Ella oder der Isolierung der zugehörigen Kabel. Wenn 
Beschädigungen am Gehäuse darauf hinweisen, dass der Schutz der Elektronik vor Feuchtigkeitseintritt oder 
Laserstrahlung beeinträchtigt ist oder eine Beeinträchtigung droht, oder wenn Kabelbeschädigungen auf bevorstehende 
Kurzschlüsse oder Unterbrechungen hinweisen, sind je nach Situation geeignete Korrekturmaßnahmen zu ergreifen – 
bis hin zur Außerbetriebnahme des Geräts, bis die Reparaturen durchgeführt wurden. Wenden Sie sich an den 
Kundendienst, um Informationen zu Reparaturen und Ersatzteilen zu erhalten.

	

	

	

	

	

VORSICHT: Das System darf nicht verwendet werden, wenn das Netzkabel in irgendeiner Weise beschädigt
ist.

Für die ordnungsgemäße Wartung und Reinigung von Ella werden folgende Materialien benötigt:

1. 10%ige Haushaltsbleichelösung

2. 70%ige Ethanollösung

3. Mildes Reinigungsmittel

4. Saubere, fusselfreie Tücher

5. Einweg-Linsenreinigungstücher (optional)
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VORSICHT: Die äußeren Oberflächen dürfen nicht mit Ethanol gereinigt werden.

VORSICHT: Beim Reinigen des 
Objektivfensters:

•	 Verwenden Sie keine Bleichmittel

•	 Berühren Sie das Objektivfenster 
ausschließlich mit dem nicht 
scheuernden Tuch

VORSICHT: Achten Sie beim Reinigen der Aufnahme darauf, das Objektivfenster nicht zu verunreinigen.

Reinigung der Kartuschenaufnahme und des Objektivfensters
Kartuschenaufnahme

Falls erforderlich, reinigen Sie die Kartuschenaufnahme von Ella mit einem nicht scheuernden, fusselfreien Tuch, 
das mit 70 % Ethanol angefeuchtet ist. 

Objektivfenster

Achten Sie darauf, dass das Objektivfenster stets 
sauber ist. Falls eine Reinigung erforderlich ist, 
verwenden Sie ein sauberes, nicht scheuerndes, 
fusselfreies Tuch, das entweder mit einem milden 
Reinigungsmittel oder mit 70 % Ethanol angefeuchtet 
ist, und wischen Sie das Fenster, bis es streifenfrei 
ist. Es wird empfohlen, mehrere Einmaltücher 
zu verwenden, um sicherzustellen, dass das 
Objektivfenster streifenfrei gereinigt ist, siehe 
Abbildung 13.
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Kartuschenaufnahme und Objektivfenster

Objektivfenster

Kartuschenaufnahme

Reinigung und Wartung des Lüfterfilters
Ella muss stets ausreichend belüftet sein, um eine ordnungsgemäße Kühlung zu gewährleisten. Eine geeignete 
Kühlung ist erforderlich, damit Ella die Spezifikationen erfüllt und eine Überhitzung vermieden wird. Die 
regelmäßige Wartung des Geräts sollte die Kontrolle und Reinigung des Lüfterfilters alle sechs Monate umfassen.

Vorgehensweise zur Reinigung des Filters:

1.	 Entfernen Sie die Lüfterabdeckung und den Lüfterfilter.

2.	Saugen Sie den Lüfterfilter ab, um ihn zu reinigen.

3.	Tauschen Sie bei Bedarf abgenutzte oder beschädigte Lüfterfilter aus (Teilenummer 541401).

4.	Setzen Sie den Lüfterfilter und die Lüfterabdeckung wieder ein.

Reinigung der äußeren Oberflächen
Schalten Sie Ella aus und trennen Sie das Netzkabel, bevor Sie mit der Reinigung beginnen. Falls erforderlich, 
wischen Sie alle äußeren Oberflächen von Ella mit einem leicht feuchten, nicht scheuernden Tuch ab, das mit 
einem milden Reinigungsmittel angefeuchtet werden kann. Wenn Zubehörteile wie das USB-Kabel oder der 
Barcode-Scanner gereinigt werden müssen, kann dies ebenfalls mit einem leicht feuchten, nicht scheuernden 
Tuch erfolgen, das mit mildem Reinigungsmittel befeuchtet ist.
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